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 PowerPoint 2007 
What am I looking at? 

Office Menu 

Quick Access 

toolbar 

Command Tabs 

Ribbon 

Help 

Status Bar 

Slide  

Preview 

Pane 

Normal view 

Slide Sorter 

Slide Show View 

Dialog Box 

Launcher 

Content 

Icon 

Title  

Box 

Content/text 

box 

Task Pane 

Group 

Button 
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Tabs at a Glance 

Home Tab 

Insert Tab 

Design Tab 

Animations Tab 

Slide Show Tab 

Review Tab 

View Tab 
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Tabs at a Glance 
 The Home tab is where you start and has the most common functions, such as 

adding and deleting slides, cut, copy and paste, and formatting text and lists. 

 The Insert tab is where you go to add content to a slide. Content includes    

tables, pictures, charts, SmartArt, text boxes, WordArt, video clips, and audio. 

 The Design tab is where you go to set the overall look of your presentation 

with themes and page set-up. 

 The Animations tab is where you go to add animation to any object as well as 

add transition effects to the slides.  

 The Slide Show tab is where you go when you want to tweak and test how 

your presentation will run. You can customize your show by setting the timing 

of the slides, recording narration, and specifying what slides get used in a 

show. 

 The Review tab is where you can run spell check, add or delete comments, and 

protect you presentation file.  

 The View tab is where you go when you want to switch between the different 

views: Normal, Slide Sorter and Slide Show. You can also access the Slide 

Master from this tab, as well turn the ruler and gridlines on and off.  

LINKS vs. EMBEDDED 

The Catch 22 of adding objects 

 

Links are directions to objects located outside of the PowerPoint file and use  

programs other than PowerPoint to open. 

Embedded objects become part of the PowerPoint file. 

 

If you move a linked object to another location, the link is broken and the object 

will no longer be in the PowerPoint. 

PowerPoints with many embedded objects become very large and freeze or skip. 
 

So, what should I do? 
 

Package all PowerPoints with links. 

Resize large objects (such as pictures) before embedding them. 
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 The Art of Right Clicking 

6 

1 

5 7 

4 

8 

One of the easiest ways to navigate through PowerPoint is through right clicking with the 

mouse. Right clicking in different areas of the screen reduces or eliminates the need to click on 

different command tabs. 

All right clicking menus include Cut, Copy, and Paste at the top. 

1. Blank area of Slide 

2. Slide in Preview 

Pane 

3. Slide in Outline Pane 

4. Shape 

5. Title/Text box 

6. Notes 

7. Picture/Clip art 

8. Media Clip 

2 3 

1 

2 

3 

4 

5 

6 
7 8 

Right clicking on any text brings 

up a mini-toolbar. 
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 Formatting Content 
PowerPoint Content includes text boxes, pictures, videos, audio, SmartArt, WordArt, clip art, 

charts, and tables. 

Resizing/Moving 

All content can be resized by clicking and dragging on a handle. To keep items proportionate, 

drag from a handle in the corner. 

Text boxes, pictures, shapes, WordArt, and clip art can be rotated by clicking and dragging the 

green rotation button. 

Handle 
Moves content 

Resizes content 

Changing the background color, adding lines, shadows, or adding 3-D aspects like depth is done 

through formatting. Some formatting options do not change, no matter what the content.      

Specialized formatting is best done through the Format command tab, but right clicking is 

faster for general formatting changes. 

Fill -- Changes the background of the slide or the area behind the content. 

The background can be filled with colors, textures, or pictures. 

 

Line Color -- Adds or erases a line (border) around content. 

 

Line Style -- Changes the lines, such as making it thicker or dotted. 

 

Shadow -- Adds or erases shadows around content. 

 

3-D Format -- Change the depth, contouring, and even the lighting of     

content. 

 

3-D Rotation -- Changes the rotation, including flipping and adding       

perspective (rotating on the Z-axis). 

 

Picture -- Adjusts the brightness and contrast of a picture, video, or clip art. 

 

Text Box -- Changes the alignment (horizontal or vertical) of text or makes 

columns. 

Rotation 

Handle 
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 Starting a New PowerPoint 
By default, new PowerPoints begin with one title slide, using the Office theme.  

Adding Slides 

Automatically add 

a Title & Content 

slide 

Select a slide layout 

from the gallery 

Changing the Layout 

Deleting a Slide 

Some buttons have two parts and will 

have a line between the icon on the top 

and the text with an arrow on the bottom. 

Clicking the icon will automatically do a 

predetermined action while clicking on 

the text allows you to choose an action. 

 

Duplicating slides is a good idea before 

turning text into Smart Art or making 

complex bulleted lists.  

 

Reset will remove all formatting changes 

(like different fonts) but will not delete 

any content. 

Home Tab       Slides Group       New Slide Button 

or  

Right click in the Slide Preview task pane and select New Slide 

or 

Use the keyboard shortcut CTRL+M 

 

New Slide Button 

The New Slide button has two parts.  

Clicking the upper half (showing the slide icon) will add a Title & 

Content slide if the only other slide is a Title slide, or it will add a 

slide using the previous slide layout (i.e. adding another Blank 

slide if the previous slide is Blank). 

Clicking the lower half (New Slide with a down arrow) will      

display the Gallery so you can choose which layout to use. 

Home Tab      Slides Group      Layout Button to view a 

drop down gallery of layouts 

or 

Right click on a blank area of the slide or on the slide located 

in the Slide Preview task pane and select Layout 

Home Tab      Slides Group      Delete Button 

or 

Left click on the slide in the Slide Preview task 

pane and hit the delete key on your keyboard 
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Shoot Me Now: Working with bullet points 

PowerPoint, like Word, uses the Enter key to define 

paragraphs. Each bullet starts a new paragraph, even if 

the preceding paragraph was only one word or short sen-

tence. If a bullet list looks double spaced even though the 

line spacing is set to 

single, use the Dialog 

Box Launcher on the 

Paragraph group to 

set the before and 

after paragraph  

spacing to 0. 

 

PowerPoint automatically bullets every thing you type into a Content box (but not text boxes, 

like the Title box). Another bullet is inserted every time the Enter key is pressed. 

 

Use the Tab key to indent bullet points, and Shift+Tab to decrease indention.  

The Increase and Decrease List Level buttons will also change indention. 

 

Bullet shape, size, and color can be customized by clicking on the Bullet button 

down arrow or by right clicking in the Content box and letting the mouse cursor 

hover over Bullets. 

 

How to remove bullets: 

 Backspace before typing in a Content box 

 Home Tab        Paragraph Group       Bullet Button 

 Right click on the Content box and select None under the Bullets listing 

Text 

Increased 

indention 

Decrease 

indention 

Tips for using bullet points effectively 

Under the Home command tab, the Font group has many of the same 

buttons as Word, such as changing the size or making font bold or italic. 

 

The Paragraph group has familiar buttons, like alignment (left & right 

and up & down) and line spacing, as well as the bullet/list and indention 

buttons. 
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Tables & Charts 
Making a Table 
Insert Command Tab       Tables Group      Table Button 

or 

Click on the table icon in a Content box 

 

The majority of functions related to tables are found in the special 

Layout command tab, but many can be found in the drop down list 

after right clicking on the table. 

 

Dragging handles will increase and decrease cell and table size. 

Making a Chart 
Insert Command Tab       Illustrations Group       Chart Button 

or 

Click on the chart icon in a Content box 

The right clicking options vary depending on the part of the chart selected. 

X X 

X 

X 

X 

X 

X 

All right click 

menus have 

these options 
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To Create SmartArt using Existing Text in a Content Box 
 

1. Home Command Tab      Paragraph Group      SmartArt button 

or 

Right click on the text and select Convert to SmartArt 

 

2. Select a SmartArt graphic or click on More SmartArt Graphics for more options. 

 

3. Use the Design and Format command tabs to change the color, outlines,  and to add/delete 

shapes. 

Bulleted text can be converted to SmartArt, but SmartArt cannot be converted back to 

bulleted text. When in doubt, make a duplicate slide of your text before converting. 

SmartArt is a way of presenting information with greater visual impact and graphically shows 

relationships and processes. 

Type of Information Layout to Use Example 

Nonsequential information List Parts of Speech 

Timeline or steps in a task Process How a bill becomes a law 

A continuing process Cycle Life cycle 

Organizational or decision-making 

process 

Hierarchy Family tree 

Connected information Relationship Brainstorming a topic 

Parts in relation to a whole Matrix Actions needed to show the 

teacher the student is listen-

ing 

Proportional relationships Pyramid Food pyramid 

SmartArt 

1 

2 

3 
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The Create Graphic group under the special Design command 

tab contains the buttons needed to change the overall look and 

order of shapes in the SmartArt.  

Creating New SmartArt 

 
1. Insert Command Tab       Illustrations Group       SmartArt Button 

or 

Click on the SmartArt icon in a Content box 

 

2. Select the type of graphic needed. 

 

3. To add Text, either click on the [Text] prompt in shapes  

or 

Click on the side arrows to launch the Text pane  

 

4. Use the Design and Format command tabs to change the color, outlines,  and to add/delete 

shapes. 

 

SmartArt 

SmartArt is an easy way to insert grouped shapes, but any shapes 

and most content items can be grouped together.  

 

To group objects, select all of the items by left clicking while hold-

ing the Ctrl key down or clicking and dragging. Look for multiple 

handles to confirm items are selected.  

 

Home Command Tab      Drawing Group      Arrange Button 

and then select Group 

Or  Ctrl + Shift + G 

 

The special Format command tabs has an Arrange 

group with a Group button. 

 

The Ungroup function is found in the same location or by using Ctrl + Shift + G again. 

 

Some clip art can be ungrouped into individual parts. 

 

 

Grouping and Ungrouping Shapes 

Ungroup 

Again 

Ungroup 
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Use the Picture layout of Fit to slide if you are making a slideshow 

with mostly pictures. Using this option saves you time since you 

won‟t have to repeatedly create slides and insert pictures. 

Insert Command Tab       Illustrations Group       Picture Button 

or 

Click on the Picture icon in a Content box 

Pictures & Photo Albums 

 

1. Double click on picture to select it.  

2. Click on the Crop button. 

3. Click and drag on the Cropping Handle to crop 

the picture as needed. 

4. Click the Crop button again to turn off. 

3 

2, 4 
Cropping a picture 

Creating a Photo Album 

Insert Command Tab       Illustrations Group       Photo Album Button 

or 

Click on the Photo Album icon in a Content box 

1.  In the Photo Album pop-up, click on the 

File/Disk button and navigate to the     

picture file you wish to insert. You can 

select multiple pictures by pressing the 

Ctrl key as you click. 

2. Insert text boxes as needed. 

3. Check the captions box if you want to 

have captions below pictures. 

4. Select the Picture layout and Frame 

shape. A preview of what the page will 

look at is on the side.  

5. Select a Theme if you have any saved on 

your computer.  

6. You can reorder the picture with the up 

and down arrows. 

7. Click on Create to open a new document 

with your photo album. 

1 

2 

4 

6 
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Media Clips 
Adding Videos 

Insert Command Tab       Media Clips Group       Movie Button 

or 

Click on the Movie icon in a Content box 

Inserting a movie triggers two of the special command tabs: Format and Options.  

With the exception of adding a picture border, all formatting 

changes only affect how the movie  looks on the slide, NOT how the 

movie plays during the slide show. 

 

Movies cannot be rotated or edited, but you can use video editing 

programs such as Windows Movie Maker to make changes and then 

re-import the corrected movie. If the movie is not in one of the file 

formats listed above, use a converting program before inserting. 

How it looks 

on the slide. 

How it plays during 

the slideshow.  

Playing Videos 

After inserting a video, a pop-up box will ask if you would like the video to 

start Automatically (as soon as the slide is shown during the slideshow) or 

When Clicked (when you left click on the video image during the slideshow). 

 

The Movie Options group under the Options command tab customizes how 

the movie will play. 

Button Action 

Play Movie Select if a movie should play Automatically, When Clicked, 

or Play across slides 

Hide During Show Movie does not show or play during slideshow 

Play Full Screen Movie zooms to full screen during slideshow 

Loop Until Stopped Movie plays on repeat  

Rewind Movie After Playing Movie returns to initial image after playing but does not  

automatically play again 

.asf    avi 

.mpg/mpeg    .wmv 

Supported File Formats 

 

 

 

.mov (quicktime) is not supported! 

If possible, test the video and the PowerPoint on the computer and with the  

projector you‟ll be using before the actual presentation.  



 15 

 

Media Clips 
To See or Not to See: Common Movie Problems 

Unlike pictures, which are embedded into PowerPoint, movies are linked. Most of the time, if a 

movie will not play during the slideshow, it is due to a linking problem. 

 

To check where the movie file is located, click on the Dialog Box 

Launcher on the Movie Options group. Part of the file path is shown  

under Information. 

 

If the file starts with C:\ it is on your computer and will not play on another computer. 

To Take the Show on the Road 
 

1. After you have completed your PowerPoint presentation, click on 

the Office Menu button. 

 

2. Select Publish and then Package for CD. 

 

3. To make a CD, insert a blank CD into your CD drive, click Copy 

to CD, and then click Yes. 

 

4. To make a folder, click on Copy to Folder. You will then be asked 

to name the folder and choose its location. 

 

5. This folder can be sent via email as long as it is 

“zipped” (compressed). 

Right click on the folder and select Send To and then Compressed 

(zipped) Folder. 

 

The zipped folder can be attached to emails and sent.  

Be sure to delete the file from your Sent box and empty your 

Trash as these zipped folders can be big. 

 

 
 

Two more reasons a movie won‟t play 

1. The movie is an unsupported file type (like .mov). Use a video converter to change it to an 

accepted movie file type. 

 

2. The file path is too long. A movie file located at 

C:\Users\eking.ATLSPS\Desktop\powerpoint manual\test\bunny and kittens\the best movie 

ever\is this enough folders yet\better make more just in case\one more to be safe\movie.wmv 

will not play.  
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Adding Sound 

Insert Command Tab       Media Clips Group       Sound Button Supported File Formats 

.aiff  .wma 

.au  .midi 

mp3 

Inserting a sound triggers two of the special command tabs:  

Format and Options. Double clicking on a sound icon also 

brings up these command tabs. 

When possible, avoid adding music through CD Audio Tracks. Music is less likely to skip (and 

is easier to transfer to other computers) if the track is first ripped to the computer and then   

inserted as a Sound from File. 

Sound Options Group 

Hide During Show Check this to hide the sound icon during the slideshow. 

Loop Until Stopped Check this if you want the sound to repeat.  

Play Sound Determines when a sound will start playing. If you choose 

When Clicked make sure the icon will not be hidden during 

the show. Use Play across slides for sounds (music) of long 

durations. 

Use the Animation task pane to fine tune timing 

options such as specifying exactly how many slides 

a sound should play across. 

See page 20 for more information on Custom  

Animation. 

After inserting a sound, a pop-up dialog box will ask when you 

want the sound to start.  

Media Clips 
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Insert Command Tab      Links Group       Hyperlink Button 

 

Hyperlinking is most frequently used as a way of navigating to web sites, but links can also be 

made between slides and other files. 

 

To add a link, highlight or select what will be hyper-

linked and click on the Hyperlink button. You can also 

right click and select Hyperlink. 

 

Types of Hyperlinks 

 Internet sites 

 Existing Files (pictures, documents, etc.) 

 Other slides in the PowerPoint 

 Email addresses 

 

Once you have selected the object of the hyperlink, click Ok. 

 

To remove hyperlinks, right click and select Remove Hyperlink. 

 

By default, text that is hyperlinked turns blue and is underlined.  

One way to avoid this is to use a picture or other icon and use that to hyperlink. 

Another option is to create a shape such as a rectangle and use that to hyperlink. 

 

1. Insert a shape and use it to create a hyperlink. 

2. Making sure the shape is still selected, change the font color to black and type the necessary 

text. 

3. Put the Shape Fill to No Fill and the Shape Outline to No Outline. 

Hyperlinking 

1 

2 
3 
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2 

1 

3,4 
5 

6 

Animations Command Tab       Transition to This Slide Group 

Transitions 

Adding Transitions 
 

1. Select the slide that will have the transition. 

 

2. Choose the type of transition. You can see a preview of how it will look by letting your 

mouse hover over the transitions. More transitions are available in the drop-down gallery. 

 

3. Add a sound if needed. 

 

4. Select a speed (slow, medium, or fast). 

 

5. Select how you would like the slide to advance. You can also use the Rehearse Timings  

button under the Slide Show Command Tab to set automatic slide advancement. 

 

6. If you would like all of your slides to have the same transition settings, click the Apply to 

All button. 

For professional PowerPoints, use one or two types of transitions such as a Fade. 

 

Even in more lighthearted shows, the Random transitions are distracting. 
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Animations 
Animations Command Tab      Animations Group 

 

Animations are a fun way to personalize your slideshow and provide impact for important    

content, but too many animations can confuse viewers and leave them “dizzy”. 

Adding General Animation 
 

1. Select the content you wish to animate. Check for handles if you are unsure what content has 

been selected. 

 

2. Choose an entrance animation from the drop down. Let the mouse hover to see how the    

content will look animated. 

 

3. You can click the Preview button to view your transition and animations on any slide. 

If your content has multiple parts (such as SmartArt or charts) you can animate 

it all together or by individual parts. 

 

If you allow your mouse to hover under the slide number in 

the Slide Preview Pane you will see a little star for any slide 

that has animation or a transition. 

Custom Animation 

 
Custom animation allows for more control over the type, length, and order of 

animations and is the only way to apply multiple animations to a slide.  

 

The Custom Animation task pane will appear after you select content and click 

on the Custom Animation button.  

1 

2 

3 
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Using the Custom Animation Pane 
 

1. After selecting the content, click on the Custom Animation button, and 

then click on the Add Effect button. 

 

2. From the drop down choose the type of effect and then the animation you 

want. Clicking on More Effects brings up additional animation grouped by 

Basic, Subtle, Moderate, and Exciting.  

 

3. Select how you want the animation to start and the speed. 

 

 

4. Click on the animation‟s down arrow and go to Effect Options if you 

want to add sound or Timing if you want to delay or repeat the effect. 

 

5. Repeat these steps for any additional content you want to animate or if 

you want multiple animations (such as a title fading in and then fading 

out). 

 

6. Click and drag or use the Re-Order up and down arrows to change the order. 

Animations 

Starts after you click the mouse 

Starts the same time as the effect before it 

Starts after a time delay 

Multiple Animations Decoded 1. After clicking the mouse on the slide, the Title enters 

(Green star) 

 

2. After the title, the subtitle automatically enters (green 

star) 

 

3. After the subtitle, the picture automatically enters 

(green star) 

 

4. After entering, the picture has an emphasis animation 

(yellow star) 

 

At this point, all of the content is on the slide. 

 

5. After a time delay of 3 seconds (done through Timing), 

the title exits (red star). 

 

6. At the same time as the title, the subtitle exits (red 

star). 

 

7. At the same time as the title and subtitle exits, the pic-

ture moves down in a motion path (black line). The mo-

tion path can be changed by clicking and dragging the 

start (green arrow) and stop (red arrow) points. 

The three pieces of Con-

tent (title, subtitle, and 

picture) all have a 1 next 

to them to note that all 

their animations start with 

or after the first mouse 

click.  If each animation 

was set to start with a 

mouse click, there would 

be a 2, 3, 4, etc. 
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Creating a Header/Footer 

 
Insert Command Tab      Text Group      Header & 

Footer Button 

 

You can choose to show the slide number through this.  
 

Master Page 
PowerPoint can automatically add content to each slide or notes hand-out through a Header & 

Footer or through the creation of a Master Slide. 

Use the Master Page option to create a cohesive look without manually changing elements on 

each slide such as background and font. 

 

View Command Tab      Presentation Views Group        Slide Master Button 

 

A master slide template for each different layout design is shown in the Slide Preview Pane. 

You can apply changes to the overall Master Slide, which will affect all slides no matter the 

layout, or make changes to specific layout slides. 

 

 

In this example, the font has been changed on 

the Master slide, so all slides regardless of  

layout, will use the new font. 

 

 

The background has been changed on slides  

according to layout. The Title slide layout has a 

different background image than the Content 

slide. 

 

The Slide Master view has scaled-down versions of the Command Tabs, and all buttons have 

the same function as regular PowerPoint. 

 

After making all the necessary changes, exit out of Slide Master by clicking on the 

Close Master View button. 

 

To use these specific changes for more 

than one PowerPoint, do a Save As and select 

PowerPoint Template. 

 

 

A Speech School template is located at G:\Everyone\POWERPNT 
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 Printing 
Printing Slides and Handouts 

1. Click on the Office button and then Print. 

 

2. Select the Print range. 

 

3. Choose what to print from the drop down list. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

4. Chose whether you will print in grayscale, black and white, 

or color. 

 

5. You can choose to Scale to fit paper, if the paper you are us-

ing is not Letter sized (8.5 x 11), and add a frame around the 

slides. 

Slides One slide per page, each slide fills 

the entire page 

Handouts Can print 1,2,3,4,6, or 9 slides per 

page; 3 slides per page also has 

lines next to slide for written notes 

Notes Pages One slide per page with Power-

Point notes below 

Outline View The slide outline printed on one 

page 

Grayscale Black & white 

If you select Preview (either through the Office 

menu or the Print dialog box), you will get a 

special command tab. 

The Print Preview command tab has all of the 

same options as the Print dialog box but has a more accurate 

preview of how your slides/handouts will look when printed. 

To Print or Not To Print 
Printing and distributing handouts before a presentation allows the 

audience to take notes; it also allows them to read ahead and ignore 

the speaker. If the majority of your information is not found on the 

slides, you‟ll want people to take notes. If most of your information 

is in the slides, distribute afterwards or offer to email the presentation 

to those who request it. 
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 Customizing the Slideshow 

Slide Show Command Tab      Start Slide Show Group       Custom Slide Show Button 

Creating a Custom Show 

1. Click on the Custom Slide Show button and select New. 

 

2. Type in a slide show name. 

 

3. Select a slide and then click Add to include it in the  

custom show. To select multiple slides, hold down the Ctrl 

key as you click. 

 

4. Click Ok when finished. 

 

You should now see your show listed as a custom show. To 

preview, click on the Show button. 

 

To play this show as the slideshow, click on the Custom 

Slide Show button and select it from the dropdown list. 

 

Custom shows are saved when you save the presentation. 

Timing the Show 

Slide Show Command Tab      Set Up Group       Rehearse Timings button 

After the Rehearse Timings button is clicked, your slide show will launch full 

screen with a time recorder.  As you progress through the slideshow, the  

recorder will note the amount of time spent per slide and the overall length of 

the show.  

 

When finished, you will have the option of using 

the slide timings to automatically advance the 

slides. Using this option will overwrite any  

timings entered when selecting transitions.  

 

Use the Slide Sorter view to see the timings of all 

of the slides. 

 

 

 

You can pause during a show with automatic  

timings by right clicking and selecting Pause. 
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In the method described above, all of the sound clips are embedded. 

 

Checking the Link narrations box causes PowerPoint to create individual sound files that are 

linked to your slides. Since the audio clips are not embedded, you can edit them (to cut out any 

“ums”) and use them for other presentations (by inserting them like any other audio clip). 

 

If you link your narrations, you will have to package your presentation (page 15) 

to play it on another computer. 

 Customizing the Slideshow 

Slide Show Command Tab      Set Up Group       Record Narration button 

Recording a Narration 

The Record Narration button will be greyed out if no 

microphone is detected. You may need to close and re-

open the PowerPoint file for it to detect the microphone. 

 

1. Click on the Record Narration button. 

 

2. Click on Change Quality, and then select the largest 

rate in the Attributes drop down list. This determines the 

sound quality of the narration. 

 

3.  Click on Set Microphone Level. When speaking in a 

normal tone and volume, the microphone level should 

show green and yellow. Use the slider to adjust if 

needed. 

 

4. After clicking Ok, you can select if you want the show 

to start on the first slide or the current slide. 

 

 

 

 

 

5. Go through your show, adding narration when needed. When 

finished, your narration (sound files) are automatically saved, 

but you can also choose whether or not to save the slide times 

(when the slides progress).  Your narrations are not deleted if 

you choose Don’t Save for slide timings. 

 

6. Your narrated audio clips show up as icons on each slide. If 

you want to remove your narration, delete these. 

2, 3 

Largest 

rate 

Slider to 

adjust level 

Gary and Chloé267.wavGary and Chloé268.wav
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 Running a Slideshow 

PowerPoint does have the option of displaying on two monitors 

during a show if you select Use Presenter View. In this mode, a 

full version of the slideshow shows on one monitor and the slides plus notes show on the other 

monitor. A projector can be used as a monitor. A computer must be able to support two displays 

(“multiple monitor capability”) to use this option. If you are interested in learning more about 

this option, contact a member of the Tech team for assistance. 

Slide Show Command Tab      Set Up Group       Set Up Slide Show button 

 Setting up a Slideshow 

1. Select a Show type. The most common 

type is Presented by a speaker. 

 

2. Under Show options, check the Loop box 

if you want your presentation to repeat. You 

can also choose to turn off recorded narration 

and animation. 

 

3. Select which slides will show.  

 

4. Select how the slides will advance. 

 

5. If the Multiple Monitor option is available 

and applicable you can check the Show Pre-

senter View box. 

 

6. Click Ok when finished. 
 

Slide Show Command Tab      Start Slide Show Group 

 

F5 will also start the show from the first slide. 

 

To progress -- Left mouse click, Right or Down arrow key, „N‟ key 

To go back -- Left or Up arrow key, Previous navigation arrow on screen, „P‟ key, Backspace 

 

End a show -- Esc key 

 

Modifying a Presentation 
 

During the slideshow, click on the pen icon located in the lower left-

hand corner of the screen or right click anywhere on the slide. Use 

the Eraser options to remove notations during a presentation. At the 

end of a show you can choose to save or discard the notations.  

Dual Monitor Display 
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 Keyboard Shortcuts 
Basic  

New  CTRL+N 

Open  CTRL+O or CTRL+F12 or ALT+CTRL+F2 

Save  CTRL+S or SHIFT+F12 or ALT+SHIFT+F2 

Save As                        F12 

Cut  CTRL+X or SHIFT+DELETE 

Copy  CTRL+C or CTRL+INSERT 

Undo CTRL+Z or ALT+BACKSPACE 

Paste  CTRL+V or SHIFT+INSERT 

Print CTRL+P or CTRL+SHIFT+F12 

Select All CTRL + A 

Group/Ungroup CTRL + SHIFT+ G 

  

Working with Bullet Points  

To promote a paragraph  ALT+SHIFT+LEFT ARROW or SHIFT+TAB  

To demote a paragraph  ALT+SHIFT+RIGHT ARROW or TAB  

To move selected paragraphs up  ALT+SHIFT+UP ARROW  

To move selected paragraphs down  ALT+SHIFT+DOWN ARROW  

  

Slideshow  

Start Show from Beginning F5 

Start Show from Current Slide SHIFT + F5 

To perform the next animation or advance to 

the next slide  

N, ENTER, PAGE DOWN, RIGHT ARROW, DOWN 

ARROW, or SPACEBAR (or click the mouse)  

To perform the previous animation or return to 

the previous slide  

P, PAGE UP, LEFT ARROW, UP ARROW, or 

BACKSPACE  

To go to slide number  number+ENTER  

To display a black screen, or return to the slide 

show from a black screen  

B or PERIOD  

To display a white screen, or return to the slide 

show from a white screen  

W or COMMA  

To stop or restart an automatic Show  ESC, CTRL+BREAK, or HYPHEN  

To erase on-screen annotations  E 

To return to the first slide  1+ENTER (or press both mouse buttons for 2 seconds)  

  


